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Team collaboration

First, be a team!

Get to know each other
e \What are their working styles?

e What is the best way you can work together?

Communicate

e Talk. A lot. (Teams messages are good, but calls and meetings foster invaluable

discussions. Don’t skip them.)
e Decide as a team who will be responsible for what.

e Set clear expectations around what progress looks like, deadlines, etc.

Optional: Get the creative juices flowing in Figdam.

Figdam: the whiteboarding tool

Much like Mural or InVision’s Freehand, Figdam offers a collaborative digital

whiteboard the whole team can work in simultaneously.

Though these files don’t have all the same features as a design file, Figdam is a
great space to share initial ideas, pose questions, gather competitor screens and

start collaborating as a team.

Figdam also offers a variety of templates to help facilitate meetings, brainstorm

sessions, research exercises and more. For new teams, new projects (or both!) this

can be the perfect place to start.
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Next, create a collaborative working environment in
your file.

Make sure everyone has a seat at the table.

All UX Design roles are important and should be able to edit the file. Each team

member should be comfortable doing the following:
e Working in Figma
e Navigating documents
e Working with components and variants
e Editing text

If you have teammates who aren’t comfortable completing these tasks, set up
some training time. The best way to get comfortable with a new software is to get

in it and start playing around! The Figma Standards & Education team can be a

great place to start.

Build edit-friendly layouts.
e Use autolayout to keep your page spacing consistent.

e Create content components to allow for global editing.

e Turn common mockups into local components for consistent display and easy
edits.

Track and mark changes.
e Create notes to keep your team informed about updates.
e Call out changes for developers.

e Keep a revision history.

2 Continue to Working in Figma
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@ TIP: You can minimize the number of notification emails by setting your profile to receive only

'J; Team collaboration _ - o . . .
mentions and replies in the notifications section of your profile settings.

& Working in Figma

[ Content in Figma Keep the document tidy
&0 Components Figma is a collaborative space. Keep your files organized so any colleague can find = = =
what they’re looking without having to track you down.
5= Variants . .
e Use Frames (F) or Sections (shift + S) to group related screens.
el e Only add finalized screens to the wireframe page, and keep WIP separate. I

e Merge/delete/archive branches when you’re done with them.

~ Accessibility

Q

Version history

< File delivery Use auto |ayout i
rame -
X Y
< Go to standards - .
When building out your designs, be sure each component and screen has an w 736 H 423
appropriate auto layout set up so content can flex without overlapping other — Fixed © X Hug -
screen elements. ho0° 8

(J Clip content

Auto layout allows you to set the following parameters:

Auto layout
e Margins W o [==-
e Spacing between elements = 40
e Wrapping rules (fixed width, fill container, hug contents) = T 0

Check out this guide from Figma for more information or explore the auto layout

playground.

Naming and labels

Name your branches, pages, sections, layers, groups and frames. Names should be

simple and reconizable. Use title case and avoid atomic design language.

To ensure updates are easy to find, add large-font labels and visual indicators.

Updated

New Modal 5.5
MS-19843
MS-20907

MS-17015

3.0 Branch Locator Branch Cards 4.0 Review Modal 5.Xx Modals

Less is more

When possible, only create what is necessary for groups, layers, frames, etc. Avoid

over-nesting.

[£ Continue to Content in Figma
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Content in Figma

Tips, tricks and shortcuts

How to...

Copy/paste text if you don't have edit access

e Select textbox > right-click > Copy/Paste as > Copy as text

e Don’t use right-click > Copy

Link directly to a frame within a page

e Select the frame > right-click/CTRL > Copy/Paste as > Copy link

e Link will take you directly to the frame, not just the page.

seful Tips

Tips

how to cop
how to link SEEEIETEE

how te emb eeliee
highlight tex

Recover content from a previous version

Previous versions are view-only. To copy content, you’ll need to duplicate

a version. Don’t use restore, or you could affect updates to the file.

To duplicate:

Select the version you want to recover.

Click the horizontal menu next to it, and select Duplicate.

e Figma will show a notification that the version has been duplicated (in

Drafts).

Shortcuts for content (Mac)

Figma-specific

e Keyboard shortcut menu: ctrl + shift + ?

Show/hide comments: shift + ¢

Show/hide side nav bars: cmd +.

Embed a link in text: highlight text > cmd + k

Click Open to open the duplicated file in a new tab.

e Select a text layer in one click (deep select): hover over field > t

e Use find and replace:

e cmd +f

e Search box appears in top-left, just under Figma navigation.

e Switch to ‘replace’ mode or change other properties in ‘Settings’ —

to the right of the search box. Settings icon:

All applications

e en-dash: option + hyphen key

e em-dash: shift + option + hyphen key
e ellipsis: option +;

e trademark ™: option + 2

e copyright ©: option + g

e registered mark ®: option +r

e Single left quote “: option + |

e Single right quote ’: shift + option + |
e Double left quote “: option + |

e Double right quote ”: shift + option + |

e Nonbreaking space: option + space

e Character viewer: ctrl + cmd + spacebar (or try fn key)

Learn more about our Content in Figma standards >

45 Continue to Components
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Why use components?

lJ) Team collaboration

O Working in Figma Components save us from unnecessary rework. Instead of having to redesign

standard screen elements, you can use the already-baked component from the

[ Content in Figma Shield library (or other libraries as needed).

A G By using instances of the same component across screens, you can select, edit and

update all instances in one place.

5= Variants
Branching

2. Accessibility When to use components

Q

Version history Short answer: Always. Use Shield components as the building blocks of your
designs. From there, create local (in-file) components to control content and

« File delivery designs in one place, no matter how many instances you need.

< Go to standards

How to access components . I . []- W T
1. Go to your file’s Assets tab. - Layer Page1 -
2. Select the library dropdown or use the search field to find the necessary Caarol as8ats. . M

component from your connected libraries.

Each bold accordion label signifies an individual library file. In our example, All libraries =

we’ve opened the React / § Shield Select library component. React / @ Select

3. Drag and drop what you need into your file.
v Component (latest version) / Approved pres...

Label text
Placeholder text v

How to use components for content management

Content components are local main design components that you use as your

content source of truth.

Use them by creating components out of appropriately styled headings, text and
other elements (including Shield components). Your new component is your single

source of truth.

Keep your file clean and manageable by organizing these components into their

own clearly labeled section or frame.

@ TIP: Need to use the same content across multiple files? Consider using the Qi method and

creating a Single Source library file.

Avoid multiple versions of the same component

Make use of variants within Figma by combining similar components into variants.

As an example, don’t make 10 buttons when 1 button with 10 variants will do.

Use layer booleans to show or hide elements instead of creating excessive variants.

el AL N T TR

« Button

You can use the layer properties

O Pass through ~

Layer boolean to toggle icons, content
B Utto n I a bel or variants within a component.

See what Figma has to say about Components >

8= Continue to Variants
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Why use variants?

J; Team collaboration
O Working in Figma e Maintain localized and selectable component variations.
e Simplify instances with configurability. Adjust the properties instead of creating

[Z Content in Figma a separate screen variation.

e Replace existing components instantly using a toggle or dropdown.
g Components

= Variants

Branchi I
ranching When to use variants

~ Accessibility
When you have multiple versions of similar components or content.

Q

Version history

Avoid creating too many variations of a component to the point it becomes
2 File delivery unmanageable. Consider nesting instances within a component (using
interchangeable parts and layer booleans) or use base components instead.

< Go to standards

Nest instances within the base

Don’t create multiple versions .
component to create variations

s Button

( )

+,
& Sa... %* Button

Button K (5] Button

% De...

[5) Button

You can achieve the same results with fewer variations.

]

1] Button I

<> Button -

[E] Button

Instance

(+) Button :

Using variants for dynamic content options

Do you have pieces of copy that need to change slightly when presented to
different audiences? Instead of creating a content component for each audience,
use variants to easily swap the text without having to change the components

within the design.
In the example below, the intro content component has two variants, one for

checking accounts and one for savings. The instance in the design now has a

toggle option to swap between the checking intro and the non-checking intro.

INTRO

CHECKING ACCOUNT

Set your limits.

Variants of the main intro content

component.

Manage your spending with daily, weekly or monthly withdrawal limits.

SAVINGS ACCOUNT

Set your limits.

Manage your spending with daily or weekly withdrawal limits.

------------------------------------------------------------------------------------------------------------------------------- [(J Clip content

Instance of intro component in the
%HECKING ACCOUNT U] dosi " P | |
= - G esign, now with control toggle.
Set your limits. & ntro
Manage your spending with daily, weekly or monthly withdrawal CHBERIRY o«
jmits. 4
Fill x Hug Antn lavnnt R

Follow Shield conventions when naming variants

Toggle variant: use “yes” and “no” as the options to stay consistent with Shield

guidelines.

Adding descriptions

Components, variant groups and individual variants within a group can have a

description added to help describe and define usage.

Button Ed vlip content

Component configuration

X <+ Button Component configuration

Description Properties =+

[E) BUttO| Tris is a test buttor

%> Show lcon

T Label

— - Auto layout —_
B I S Hi =1 & &P Y

[5) Butto

Link { Butto

] ' This is a test button

State Default -

(] Simplify all in a e
@ S V Show Icon [ @)

Hide layers w
effects, auto Label Save

Be consistent with variant properties

Name layers, groups and auto layouts.

Keep property names, values and order consistent.

See what Figma has to say about Variants >

Continue to Branching
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What is branching?

lJ) Team collaboration

O Working in Figma Branches are exploratory spaces that allow designers to safely try new ideas

without affecting the main design file. When you’re ready, the changes from your

[4 Content in Figma branch can be merged into your main file.

o Components

Variants

When to use branches

Branching

Contributing to a shared library

Accessibilit . .
- I Non-editors can create a branch to demonstrate their proposal for a component

modification or addition to existing libraries.

Q

Version history

Modifying components or variants
< File delivery

Test modifications to complex components, create new components and variants

= Go to standards or modify a shared style without breaking your main file.

Freezing features for dev handoff

If your team is delivering in sprints, you can preserve the main file for development
while you work a sprint ahead. Create a branch for the next sprint that your team
can work in. You can use this branch for getting product owner approval and
sharing updates with your team. When it’s time to hand off the updates, merge the

changes into the main file.

[T — 1

Main file Create branch  Mainfile B e
el - D
l-_ X |

ilaslgr! (-‘Pﬂﬂ.’;ﬂﬁ ‘ Review changes Merge changes

Best practices when using branches

Naming branches

Name your branches to clearly communicate what they contain or address. Prefix
the branch name with something to quickly identify it. This could be a story

number, type of work or similar:

e UX-5141: Redesign login screen
e |ayout fix for payment info

e [contrib] - Propose a new design for tabs

Requesting review

If you are a viewer on a file you won’t be able to merge the branch directly and

need to request a review from an editor.

When requesting a review give as much context as possible. Fill out the
description field with the details of your proposal or issue being solved to help the

editors know what they are reviewing in your contribution.

Merging branches

When you want to apply your changes to the main file, you can merge the branch.
If you're an editor on the main file, start the merge to review any changes from

main in the branch and resolve any conflicts that appear.

After a branch has been merged into the main file, it's automatically archived along
with all comments made within it and can no longer be restored. If you need to
undo a merge, you can restore a previous version of the file from the version

history.

Archiving branches

When you have designs in a branch that you’ve decided not to move forward with
right now, you may want to archive it in case you or your team want to come back
to it at a later time. If your branches have been archived without being merged into
the main one, they can be viewed or restored at any time, making it easy to recover

them if you need to revisit an idea.

2 Continue to Accessibility
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Accessibility

Create screen reader friendly prototypes

The “adapt content for screen readers” feature in Figma converts any prototype
into a basic HTML page. This HTML page can be navigated and interacted with via
a screen reader like VoiceOver, JAWS or NVDA.

This feature is activated at the user level and can be found when viewing a

prototype in the Options menu under Accessibility settings.

Accessibility settings

& Adapt content for screen readers

When enabled, Figma prototypes and Figjam whiteboards will provide
text and structure for screen readers and other assistive technologies.

How does it work?

When “adapt content for screen readers” is turned on, and the HTML page is

generated, the following occurs:

1. Top-layer frames &, components #¢, instances <>, and overlays become an

article element.

2. Text is wrapped in a paragraph tag and links inside of text will be wrapped in a

link tag.
3. Lists will be turned into ordered/unordered lists.

4. Any shape with an image fill will become an image, and the layer's name
becomes the alt text <img alt="layer's name">. This includes any non-top-layer-

frame that only houses an image.

5. An element with an "On Click" interaction will be converted into a button or a

link depending on the type of interaction.

Screen readers can navigate through the page's text and will hear the names of any
layer, frame, component, or overlay. They can also interact with any buttons or

links generated by "On Click" interactions.

How is it different from a native web experience?

Screen readers rely on a web page’s programmatic structures, like headings and
form fields, for context and navigation. Prototypes in accessible mode don’t have

some, or all, of these structures.

That's okay since prototypes aren't meant to be full-fledged web experiences. That
said, we can take some small steps to pass some of the design's structure to the

screen reader and ensure what gets read is in the order we want.

How are screen reader friendly prototypes used?

Team members who use screen readers

Screen readers are used by people who are blind, have low vision, or have reading
differences like dyslexia. These prototypes ensure all team members can reference

your designs in prototype mode.

Accessible research

Screen reader friendly prototypes allow research to include a more diverse set of
participants. Individuals who use screen readers can explore your design and give

feedback which helps to ensure your designs are fully accessible.

Tips for optimizing screen reader friendly prototypes

You’ll notice the tips for ensuring prototypes are screen reader friendly are in many
cases the same best practices provided throughout this guide. That’s because

good design and accessible design are the same.
Components

Since components become articles when adapted for screen readers in prototype
mode, they are a great way to provide some semantic structure. When a screen

reader encounters the component, it will announce the corresponding region in the

design.
@mnk hrnsages “ Locations. Sacurty  Profile & settings Log out
<> Primary Nau\*
.{ Dashboard My accounts Transfers PayBills Send money Customer service Products & services
Line i ®
R R How did we do?

@bank Messages o Locations Security  Profile & settings Log out

Dashboard My accounts Transfers Pay Bills Send money Customer service Products & services

* Primary Nay, article

The “Primary Nav” component example above shows the VoiceOver screen reader's

caption panel displaying what the screen reader announces, “Primary Nav, article.”

Give layers understandable names

As shown in the example above, screen readers announce whatever name you’ve
given your top-layer frames t, components ¢, instances < and overlays from the
layers list. These elements can also be presented in a list and used as navigation for

screen reader users.

In order for your prototype to be understandable and navigable you must use clear,

descriptive names for each of these elements.

Layer order = reading order

When rendering your prototype, Figma will “build” your design by reading your
layers list from top to bottom. It is essential that the order of your layers list
matches the visual order of your design (commonly left to right, top to bottom).

Otherwise, screen reader users will be presented information out of order.

Layers Assats® Page 1 '
:tt How did we do [ Customer service | U.S. Bank @bank Mgy o- Leseitionrs Eacyrily Profile & siings Lclg ot
Haader
Dashboard My accounts Transfers Pay Bills  Send money  Customer service  Products & services
Likility Nanw
Primary MNav
Lina j M
. How did we do?
Background '
= Body Please take a moment to tell us what we did right!
How did we da?
[ Plaase take a moment o tell us what we did ri...
Mame
< Mame Text Input s ® = J B
iequiras |
| O
Comment Text Area
Submil Button Tall us more!

T Success Page

Feaulred characters eft

In the example above, frames and instances have all been given clear,
understandable names in the layers list. The screen reader user will hear these

readable names as they navigate the prototype.

The top-level frame has been given the intended page title. When a screen reader
encounters the beginning of the prototype, they will hear the frame’s name

announce, similar to native web.

Learn more about our Accessibility standards >

> Continue to Version history
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Autosaved versions

'd) Team collaboration
Figma records every change made to a file within its version history. You can

L access it through the main menu (File > Show version history) or from the
& Working in Figma
dropdown at the top of your file.

[4 Content in Figma Figma Guidelines / Figma standards . 1branch

Show version history

g Components :
Publish styles and components

Export... 4 #HE

s— Variants

Branching Named versions

To make your version history easier to navigate, you can save a named version. This

~ Accessibility can be helpful when you change a file name, incorporate changes from a review

or make other significant updates.
Version history

Q

File > Save to version history > enter a descriptive name (and optional detail in the

¥ File delivery “Describe” box) > Save

< Go to standards Add to version history

Back to files

. Quick actions...

File New design file
Edit New FigJam file

View MNew from Sketch file...

Text Place image...

Arrange
Save local copy...

Vector

Save to version history...

Approved plugins for U.S. Bank show version history
Widgets

Export...
Preferences

Export frames to PDF...
Libraries

Create branch...
Get desktop app

Example names; descriptions:

e Content manager review; Edits and responses to Logan review
e Redesign using cards; This follows feedback from Roman on 5/25/2022
e Tier 1 review comments; July 10, 2022

e Ready for final reviews; Updates by Shiv and Kendall after Tier 1

Learn about our Version control standards >

¥/ Continue to File delivery
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Sprint handoff - Ready for dev

lJ) Team collaboration

To make it as easy as possible for developers to find updates they need to make,

& Working in Figma use the “Ready for dev” feature.
4 Content in Figma Step 1: Select the completed component, instance, frame or section.
Pages
45 Components
M (13 99 ° ° . C
Step 2: Click the “Mark as ready for dev” icon in the toolbar or section heading o
8= Variants : e : : o // Guidelines
Doing so will highlight the page in the file navigation as well as the element that
includes your changes. Your developers will be able to select the dev indicator, Standards
Branchin : :
° open the work in dev mode and compare the changes. v Best Practices
2 Accessibility
File delivery ile delivery

Version history

Q

D

" Open in Dev Mode
< File delivery RS File Copy dev link
& Working in Figma Remove ready status
Sprin

[#) Contentin Figma

< Go to standards

Section 1 {lﬂ’. Section 1

»,

|

Section1 ]

Open in Dev Mode

Mark as ready for dev

Remove ready status

When using this feature, be sure that your screens are ready for AEM authoring,
dev and CAT (if applicable).

Learn more about our File delivery standards >

[E Continue to Standards



Revision history

Screen ID Description Author
04/07/2023 Accessibility Added accessibility standards per the A11Y team. W McDonald
04/11/2023 Libraries Hiding libraries until there is more info W McDonald
04/12/2023 Variants New visuals W McDonald
08/02/2023 Team collab Team collab - Added Figdam section, jumplink to content components W McDonald

Working in Figma Working in Figma - Added screenshots in first two sections

Content in Figma Content in Figma - Net-new frame

Components Components - Added How to access components and How to use components for content management

Variants Variants - Added Using variants for dynamic content options

File delivery File delivery - Net-new frame

Select the columns you need from the design panel before detaching.
Press Command + D to add a row




